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Deltek’s software is also protected by copyright law and constitutes valuable confidential and 
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Overview 
This document includes all of the enhancements, software issues resolved, and database changes that 

were made in Cobra 8.6 Cumulative Update 01 through Cobra 8.6 Cumulative Update 14. 

Custom Programs Affected 

Sometimes an update can cause custom programs and reports to stop working as expected. Before 

applying this update, consider whether you have any custom programs or reports in the application area 

affected by the update. If so, contact a Deltek Support Services analyst at https://support.deltek.com 

before you install the update. 

 

Viewing the Help System 

The Deltek Cobra Help System provides help for all areas of the Cobra application. 

 To access all documents available for Cobra 8.6, click 

https://help.deltek.com/Product/Cobra/8.6/GA. 

 To access the printable version of the Cobra Help System, see Cobra Help System in Portable 

Document Format. Take note that some of the links in the PDF version may not work. 

 To view the collection of videos that will help you work with Cobra, see Cobra Videos. 

Software Requirements (Compatibility Matrix) 

To see the list of the supported and compatible technologies, see “System Requirements” in the Deltek 

Cobra 8.6 Installation Guide.  

For a complete list of the recommended minimum software requirements, see the Deltek Product 

Support Compatibility Matrix document, which you can download from the Deltek Support Center site. 

Integration with PM Compass 

If you are upgrading from one version of Cobra to another and are using PM Compass, ensure that you 

install the version of the Cobra Integration for PM Compass file that supports the specific versions of 

Cobra and PM Compass you plan to use. 

 For PM Compass 8.4 or earlier, the integration file is typically released prior to or alongside the 

PM Compass Cumulative Update (CU) and must be installed manually. 

 For PM Compass 8.5 or later, the CU installer includes the integration installer, which 

automatically installs the compatible Cobra engine—no separate installation is necessary. 

Attention: For steps to install the cumulative update, see “Appendix A: Download and Install the 

Cumulative Update” in this document. 

https://support.deltek.com/
https://help.deltek.com/Product/Cobra/8.6/GA
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=9554FC0B-A900-4BC6-BC1F-3E9993398C70
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=9554FC0B-A900-4BC6-BC1F-3E9993398C70
https://help.deltek.com/Product/Cobra/8.6/GA/Cobra%20Videos%20and%20Learning%20Aids.html
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=B895640B-0FB1-4CE6-B4BE-8125C7EC9429
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=B895640B-0FB1-4CE6-B4BE-8125C7EC9429
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However, if there is no PM Compass CU release, but a Cobra integration file is available, 

download it from DSM and run the installer manually. 

 

 

Note: A new integration file is not required for every Cobra CU. If no new file is provided, the 

previous version may be used if it remains compatible. 

Attention: For more information on the PM Compass Cumulative Updates and Integration Releases, 

download the related document from the Deltek Support Center site. If you have any questions, 

contact a Deltek Support Services analyst. 

https://support.deltek.com/
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Cobra 8.6 Cumulative Update 14 
Released: May 29, 2026 

Enhancements 

There are no enhancements in this release. 

Software Issues Resolved 

This section includes software issues resolved in this release.  

File » Integration Wizard-Project Data 

Defect 1441360 

Description:  When you ran the MS Project Integration Wizard to load resource assignments from a large 

MSP XML file with a missing closing tag, Cobra encountered the “.dbf or .tmp is too large” error. 

Customers Impacted: This defect affects customers using the MS Project-Integration Wizard. 

Workaround Before Fix: Split the resource file into smaller files and run each file in a separate 

integration. 

Files Updated: 

 Cobra.Process.dll 

Reports » Reports 

Defect 2616023 

Description: When you ran the Report Wizard to generate a time‑phased report and selected the 

Include multiple projects on report option on the Report page, all result values were doubled compared 

to running the primary project individually. This occurred when at least one secondary project used a 

different CLASS value for the selected cost set than the primary project. 

Customers Impacted: This defect affects customers using the Report Wizard. 

Workaround Before Fix: Run the projects separately and do not select the Include multiple projects on 

report option. 

Files Updated: 

 Cobra.Model.dll 

Security Enhancements 

There are no security enhancements in this release. 

Database Changes 

There are no database changes in this release. 
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Data Changes 

There are no data changes in this release. 

Documentation Changes 

There are no documentation changes in this release. 
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Cobra 8.6 Cumulative Update 13 
Released: April 30, 2026 

Enhancements 

This section includes enhancements in this release. 

Support for Open Plan 8.8 

Cobra 8.6 now supports Open Plan 8.8, beginning with Cumulative Update 13. 

 

 

Support for wInsight 8.3.4 

Cobra 8.6 now supports wInsight 8.3.4, beginning with Cumulative Update 13. 

 

 

Software Issues Resolved 

This section includes software issues resolved in this release.  

File » Integration Wizard-Actual Costs 

Defect 2617560 

Description: When you ran the Actual Cost-Integration Wizard against a master project, cumulative 

costs were not loaded correctly. 

Customers Impacted: This defect affects customers using the Actual Cost-Integration Wizard. 

Workaround Before Fix: Run the integration separately for each individual project instead of the master 

project. 

Files Updated: 

Attention: For more information on Open Plan 8.8, see the Deltek Open Plan 8.8 Release Notes. 

Attention: This information is documented in the “System Requirements” section of the Deltek 

Cobra 8.6 Installation Guide and Deltek Cobra 8.6 Technical Overview and System Requirements 

Guide. 

Attention: For more information on wInsight 8.3.4, see the Deltek wInsight 8.3.4 Release Notes. 

Attention: This information is documented in the “System Requirements” section of the Deltek 

Cobra 8.6 Installation Guide and Deltek Cobra 8.6 Technical Overview and System Requirements 

Guide. 
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 Cobra.Process.dll 

File » Integration Wizard-Project Data 

Defect 1596260 

Description: When you ran the File-Integration Wizard, control accounts and work packages were 

concatenated and truncated if they exceeded the maximum character limit, preventing their data from 

loading. The process log generated warnings referencing the shortened work package names. 

Customers Impacted: This defect affects customers using the File-Integration Wizard. 

Workaround Before Fix: Do one of the following actions: 

 Run the integration one work package at a time and select Work Package in the Criteria field on 

the Filter page. 

 Ensure the work package name is 29 characters or fewer. 

Files Updated: 

 Cobra.Process.dll 

Security Enhancements 

There are no security enhancements in this release. 

Database Changes 

There are no database changes in this release. 

Data Changes 

There are no data changes in this release. 

Documentation Changes 

This section includes details of section changes in the printed documentation that are in addition to any 

enhancements. 

Document Details 

Deltek Cobra 8.6 Installation Guide  Removed the “Platform Virtualization” and 

“Display Settings” sections 

Deltek Cobra 8.6 Technical Overview and System 

Requirements 

 Removed the “Display Settings” section 
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Cobra 8.6 Cumulative Update 12 
Released: March 31, 2026 

Enhancements 

This section includes enhancements in this release. 

Populating IsSummaryLevelPlanningPackage During Cost Data Export 

When exporting IPMDAR at the control account level, the IsSummaryLevelPlanningPackage value is 

now populated based on work package progress technique and control account-level budgeting 

scenarios. 

The value is set to TRUE when all work packages use the Planning Package progress technique, or when 

no work packages exist and a valid control account-level budget is present. In all other scenarios, the 

value is set to FALSE. 

 

Software Issues Resolved 

This section includes software issues resolved in this release.  

Files » Integration Cost Data Export 

Defect 2560816 

Description: When you ran the Cost Data Wizard using an existing configuration reused for a different 

project that shared the same configuration settings, Cobra displayed the “Please select a valid code” 

message in the Work Package field on the Export Structures page after you clicked Next. 

Customers Impacted: This defect affects customers using the Cost Data Wizard. 

Workaround Before Fix: Use a new configuration created from scratch instead of reusing an existing 

one. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Files » Integration Wizard-Project Data 

Defect 2577102 

Description: When you ran the Primavera‑Integration Wizard to load control accounts and work 

packages, Cobra calculated different % Complete values for the same work package depending on 

Attention: For more information, see the “Codes and Structures Page of the Cost Data Wizard” topic 

in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.6/GA/Codes%20and%20Structures%20Page%20of%20the%20Cost%20Data%20Wizard.html
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whether the integration was run using a single work package filter or an entire project (Total Project), 

control account, or multiple work packages filter defined on the Filter page. 

Customers Impacted: This defect affects customers using the Primavera-Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

Security Enhancements 

There are no security enhancements in this release. 

Database Changes 

There are no database changes in this release. 

Data Changes 

There are no data changes in this release. 

Documentation Changes 

This section includes details of section changes in the printed documentation that are in addition to any 

enhancements. 

Document Details 

Deltek Cobra 8.6 Help System  Fixed the typographical error in the “XML 

Configuration File Sample” topic 

 

https://help.deltek.com/Product/Cobra/8.6/GA/XML%20Configuration%20File%20Sample.html
https://help.deltek.com/Product/Cobra/8.6/GA/XML%20Configuration%20File%20Sample.html
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Cobra 8.6 Cumulative Update 11 
Released: March 5, 2026 

Enhancements 

This section includes enhancements in this release. 

Support for Ollama as an AI Service Provider 

EPM Security Administrator 8.6 now supports configuring Ollama connection settings through the AI tab 

in the System Settings dialog box. 

 

As part of this enhancement, Cobra has been updated to ensure full compatibility and enable the 

Narrative Score feature to function seamlessly when Ollama is selected as the AI service provider. 

 

Software Issues Resolved 

This section includes software issues resolved in this release.  

Files » Integration Wizard-Project Data 

Defect 2361128 

Description: When you ran the Open Plan–Integration Wizard, Cobra encountered the “Alias 'TMPUDT' is 

not found” error under any of the following conditions: 

 You integrated with an Open Plan master project and selected the Code Assignments and User 

Fields and Resource Assignments options on the Action Selection page. 

 You selected the Status option on the Action Selection page and the Update Assignment % 

Complete option on the Status page. 

Customers Impacted: This defect affects customers using the Open Plan-Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

Attention: For more information on this enhancement, see the Deltek EPM Security Administrator 

8.6 Cumulative Update 01 Release Notes. 

Attention: The “Enable the Narrative Score Feature” topic in the Cobra Help System has been 

updated to reflect this change. 

https://dsm.deltek.com/DocumentationLists/DeltekEPMSecurityAdministrator86GA.html
https://dsm.deltek.com/DocumentationLists/DeltekEPMSecurityAdministrator86GA.html
https://help.deltek.com/Product/Cobra/8.6/GA/Enable%20the%20Narrative%20Score%20Feature.html
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Defect 1285093 

Description: When you ran the Actual Cost-Integration Wizard, resource names in mixed case were 

integrated into the CECODE column in the TPHASE table, even if the resource names in Cobra were in 

upper case, which caused calculation errors. 

Customers Impacted: This defect affects customers using the Actual Cost-Integration Wizard. 

Workaround Before Fix: Do one of the following: 

 Option 1: Delete the imported data, update the import file so it matches the uppercase resource 

name in the resource file, and then re-import the data. 

 Option 2: Perform the following steps: 

1. Create a new resource. 

2. Copy the calculations from the original resource to the new resource. 

3. Click Tools » Replace Resource to replace the problematic resource with the new 

resource. 

4. Click Tools » Replace Resource again to replace the new resource with the original 

resource. 

5. Run the Recalc Wizard for the affected work packages. 

6. Re-run the calculations. 

Files Updated: 

 Cobra.Process.dll 

Security Enhancements 

There are no security enhancements in this release. 

Database Changes 

There are no database changes in this release. 

Data Changes 

There are no data changes in this release. 

Documentation Changes 

There are no documentation changes in this release. 
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Cobra 8.6 Cumulative Update 10 
Released: January 30, 2026 

Enhancements 

There are no enhancements in this release. 

Software Issues Resolved 

This section includes software issues resolved in this release.  

Files » Integration Wizard-Project Data 

Defect 2554746 

Description: When you ran the Primavera-Integration Wizard to load control accounts and work 

packages, and filters were already selected on the Filter page, some data might not have loaded if the 

filter fields did not exactly match the project data, such as when extra spaces were included. 

Customers Impacted: This defect affects customers using the Primavera-Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

Security Enhancements 

There are no security enhancements in this release. 

Database Changes 

There are no database changes in this release. 

Data Changes 

There are no data changes in this release. 

Documentation Changes 

This section includes details of section changes in the printed documentation that are in addition to any 

enhancements. 

Document Details 

Deltek Cobra 8.6 Help System  Updated the "Manual Performance Factors 

Page of the Calculate Forecast Wizard" topic 

to include additional and corrected 

information 

https://help.deltek.com/Product/Cobra/8.6/GA/Manual%20Performance%20Factors%20Page%20of%20the%20Calculate%20Forecast%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Manual%20Performance%20Factors%20Page%20of%20the%20Calculate%20Forecast%20Wizard.html
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Document Details 

Deltek Cobra 8.6 Installation Guide  Added the following sections to “Establish a 

Database”: 

 Required Database Permissions for 

Cobra 

 Required Database Permissions for 

EPM Security Administrator 

 



 

Cumulative Update 14 Release Notes 13 

 

Cobra 8.6 Cumulative Update 09 
Released: December 5, 2025 

Enhancements 

There are no enhancements in this release. 

Software Issues Resolved 

This section includes software issues resolved in this release.  

Files » Integration Wizard-Actual Costs 

Defect 2523431 

Description: When you ran the Actual Cost-Integration Wizard, the process took longer to complete 

than expected while checking for duplicate keys or determining the current period and cumulative actual 

costs. 

Customers Impacted: This defect affects customers using the Actual Cost-Integration Wizard. 

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 24 (Defect 2501068). 

Files Updated: 

 Cobra.Process.dll 

Files » Integration Wizard-Ancillary Data 

Defect 1424473 

Description: When you ran the Ancillary Data-Integration Wizard to import a fixed-form significant code 

file, Cobra proceeded with the integration even though the import file exceeded the specified maximum 

character length. 

Customers Impacted: This defect affects customers using the Ancillary Data-Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

Files » Integration Wizard-Project Data 

Defect 2523429 

Description: When you ran the Integration Wizard and loaded Control Account Managers (CAMs) or 

Work Package Managers (WPMs) from an import file, Cobra imported them based on the case of the 
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imported value rather than using the case of the User ID from EPM Security Administrator (EPM SA) or 

the case of the code defined in the CAM code file. 

Customers Impacted: This defect affects customers using the Integration Wizard on a non-case-

insensitive database. 

Workaround Before Fix: Manually update the CAMs or WPMs in the import file to match the case of the 

code or the User ID from EPM SA before running the integration. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 24 (Defect 2491321). 

Files Updated: 

 Cobra.Process.dll 

Defect 2484398 

Description: When you ran the Primavera Web Service-Integration Wizard on an n-tier deployment, 

Cobra did not display the Primavera P6 projects in the Schedule Project field on the Project Selection 

page. 

Customers Impacted: This defect affects customers using the Primavera Web Service-Integration 

Wizard on an n-tier deployment. 

Workaround Before Fix: Perform the following steps: 

1. Copy the PPM.P6WebServices.dll file from the Cobra directory to the Cobra\Server\ directory. 

2. Restart the IdeaBlade PersistenceServer Service service on the server machine. 

Files Updated: 

 DeltekCobra86.exe 

Security Enhancements 

There are no security enhancements in this release. 

Database Changes 

There are no database changes in this release. 

Data Changes 

There are no data changes in this release. 

Documentation Changes 

This section includes details of section changes in the printed documentation that are in addition to any 

enhancements. 
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Document Details 

Deltek Cobra 8.6 Help System  Updated the following topics to include 

additional and corrected information: 

 “Behavior of the Integration Wizard 

Preferences Options” 

 “Integration Preferences” 

 “Project Preferences” 

 Created a new topic called “Sample 

Scenarios” to explain how Cobra’s 

application-level and file-based security 

settings affect menu item accessibility for 

different user roles and groups 

 

  

https://help.deltek.com/Product/Cobra/8.6/GA/Behavior%20of%20the%20Options.html
https://help.deltek.com/Product/Cobra/8.6/GA/Behavior%20of%20the%20Options.html
https://help.deltek.com/Product/Cobra/8.6/GA/Integration%20Wizard%20Preferences.html
https://help.deltek.com/Product/Cobra/8.6/GA/Project%20Preferences.html
https://help.deltek.com/Product/Cobra/8.6/GA/Cobra%20Menu%20Sample%20Scenarios.html
https://help.deltek.com/Product/Cobra/8.6/GA/Cobra%20Menu%20Sample%20Scenarios.html
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Cobra 8.6 Cumulative Update 08 
Released: October 30, 2025 

Enhancements 

This section includes enhancements in this release. 

DOE PARS Export Updates 

The Cost Data Export feature now supports the DS22 dataset required by the DOE PARS system, 

ensuring compliance with the DOE requirements while maintaining a streamlined export process. 

When you run the Cost Data Wizard to generate the DOE PARS file format, the DS22 JSON file is now 

included in the zip file. The JSON file contains data based on the project’s contractor financial calendar, 

using Calendar 00 for the entire project duration. 

 

 

Support for Private Connections in Primavera Web Service Integration 

When using the Integration Wizard to import data from Primavera using the Primavera Web Service, you 

now have the option to mark a connection as private. This enhancement improves security and gives 

users greater control over connection visibility, supporting secure, user-specific integration workflows. 

In the New Connection dialog box, the Private checkbox has been added to enable you to mark the 

connection as private. This checkbox is selected by default when creating new connections.  

Note: Rolling wave calendar data is not captured in the export. 

Attention: For more information on how the DOE PARS export was developed, refer to the DOE 

JSON Schema page. 

https://json.pars.doe.gov/
https://json.pars.doe.gov/
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New Connection Dialog Box of the Integration Wizard 

  

Connections marked as private are only visible to users who created them and to the SYSADMIN users. 

Once a connection is saved as private, it cannot be reverted to a shared connection. To share it again, 

you must recreate the connection. 

When editing a private connection, you can update the URL, user, password, and database instance. 

However, the connection name and the Private checkbox are not editable. 

 

Software Issues Resolved 

This section includes software issues resolved in this release.  

File » Backup 

Defect 2484728 

Description: When you pressed Ctrl+F in the Backup dialog box, the Find dialog box did not display. 

Customers Impacted: This defect affects all customers. 

Note: The same checkbox has been added to the Edit Connection dialog box. 

Attention: For more information, see the “New Connection Dialog Box of the Integration Wizard-

Primavera Web Service” topic in the Cobra Help System. 

In addition, the “Test the Connection in Cobra” section under Appendix G: Configuring Oracle 

Primavera P6 for Integration of the Deltek Cobra 8.6 Installation Guide has been updated to reflect 

this change. 

https://help.deltek.com/Product/Cobra/8.6/GA/Edit%20Connection%20Dialog%20Box%20Primavera%20Web%20Service.html
https://help.deltek.com/Product/Cobra/8.6/GA/Edit%20Connection%20Dialog%20Box%20Primavera%20Web%20Service.html
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Workaround Before Fix: Right-click the column that you want to search and select Find. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

File » Integration Wizard-Project Data 

Defect 2467859 

Description: When you loaded data using the Primavera-Integration Wizard and rolled up multiple work 

packages across different Primavera activities, Cobra did not calculate the % Complete values and dates 

correctly. 

Customers Impacted: This defect affects customers using the Primavera-Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

Security Enhancements 

There are no security enhancements in this release. 

Database Changes 

There are no database changes in this release. 

Data Changes 

There are no data changes in this release. 

Documentation Changes 

There are no documentation changes in this release. 
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Cobra 8.6 Cumulative Update 07 
Released: September 25, 2025 

Enhancements 

There are no enhancements in this release.  

Software Issues Resolved 

This section includes software issues resolved in this release.  

File » Integration Wizard-Ancillary Data 

Defect 1921431 

Description: When you ran the Ancillary Data-Integration Wizard and imported a resource file that 

contained a blank row, Cobra encountered an error stating that the required fields were empty. 

Customers Impacted: This defect affects customers using the Ancillary Data-Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

Security Enhancements 

There are no security enhancements in this release. 

Database Changes 

There are no database changes in this release. 

Data Changes 

There are no data changes in this release. 

Documentation Changes 

This section includes details of section changes in the printed documentation that are in addition to any 

enhancements. 

Document Details 

Deltek Cobra 8.6 Help System  Updated the AAP Policy and Guidance link to 

API Integrated Program Management in the 

“Exported Cost Data File” topic 

 Updated the “Codes and Structures Page of 

the Cost Data Wizard” topic to include 

https://www.acq.osd.mil/asda/dpc/api/ipm/index.html
https://help.deltek.com/Product/Cobra/8.6/GA/Exported%20Cost%20Data%20File.html
https://help.deltek.com/Product/Cobra/8.6/GA/Codes%20and%20Structures%20Page%20of%20the%20Cost%20Data%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Codes%20and%20Structures%20Page%20of%20the%20Cost%20Data%20Wizard.html
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Document Details 

information about 

IsSummaryLevelPlanningPackage 
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Cobra 8.6 Cumulative Update 06 
Released: August 29, 2025 

Enhancements 

This section includes enhancements in this release.  

DOE PARS Export Updates 

In addition to assigning code files to WBS, you can now select a control account code field or a work 

package code field when assigning codes to certain fields on the WBS/OBS Codes page of the Cost 

Data Wizard.  

This update gives you greater flexibility in assigning codes required for the DOE PARS export and allows 

you to reserve WBS codes for internal management purposes.  

You can also reuse the WBS, control account, or work package code field selections across multiple 

fields. For example, if you select CA Code 1 in the Control Account Manager field, you can also select 

that same CA Code 1 for the Subproject ID, Charge Code, and IMP fields. 

  

Software Issues Resolved 

This section includes software issues resolved in this release.  

File » Integration Cost Data Export 

Defect 2448577 

Description: When you ran the Cost Data Wizard to export IPMDAR cost data, control accounts with 

zero-sum reprogramming dollar and hour values were not included in the 

ReprogrammingAdjustments.json file. 

Customers Impacted: This defect affects customers using the Cost Data Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 PPM.CommonData.dll 

Note: This information is documented in the “WBS/OBS Codes Page of the Cost Data Wizard” topic 

in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.6/GA/WBS%20OBS%20Codes%20Page%20of%20the%20Cost%20Data%20Wizard.html
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File » Integration Wizard-Project Data 

Defect 2446777 

Description: When you ran the Open Plan-Integration Wizard to load milestones, Cobra did not load any 

milestones if a subset of the record from Open Plan already existed in Cobra. For example, if Cobra had 

A.B.C.1 and you tried to load A.B.C, it did not load.  

Customers Impacted: This defect affects customers using the Open Plan-Integration Wizard. 

Workaround Before Fix: None. 

Additional Notes:  

 This issue also occurs when loading milestone weights or milestone statuses during integration. 

 This defect has been fixed in Cobra 8.5 Cumulative Update 23 (Defect 2352012). 

Files Updated: 

 Cobra.Process.dll 

Projects » Project View 

Defect 2351946 

Description: When you displayed a project in the Project view, clicked a different tab, and ran the 

Advanced Calendar Wizard for that same opened project, the Total value changed to 0.00 upon 

returning to the Project view. 

Customers Impacted: This defect affects all customers. 

Workaround Before Fix: Close the project and reopen it. 

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Model.dll  

 Cobra.Model.LoginManager.dll 

Reports » Report Wizard 

Defect 2357245 

Description: When you ran the Report Wizard, cleared the Include only non-zero results option on the 

Results page, and saved the report, the selection was not retained. 

Customers Impacted: This defect affects customers using the Report Wizard. 
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Workaround Before Fix: Manually clear the Include only non-zero results option each time you run the 

Report Wizard. 

Files Updated: 

 Cobra.WinUI.*.dll 

Resources » Resource View 

Defect 2314853 

Description: When you assigned a code at the resource level in the Resource view, Cobra encountered 

the "Invalid code assignment entered" error. 

Customers Impacted: This defect affects all customers. 

Workaround Before Fix: Perform the following steps: 

1. Display the Resource File Properties dialog box and click the Code Fields tab. 

2. In the first code field, enter a prompt, (for example, Text), set the Code Field Type column to 

Text, and click Apply. 

3. Clear the prompt, set the Code Field Type column to <none>, click Apply, and then click OK.  

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Model.dll  

 Cobra.Model.LoginManager.dll 

Security Enhancements 

There are no security enhancements in this release. 

Database Changes 

There are no database changes in this release. 

Data Changes 

There are no data changes in this release. 

Documentation Changes 

This section includes details of section changes in the printed documentation that are in addition to any 

enhancements. 
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Document Details 

Deltek Cobra 8.6 Help System  Updated the “Change Management Tags” 

topic to include the following tags: 

 ChangeManagement.TotalOT 

 ChangeManagement.DbOt 

 ChangeManagement.UbOt 

 ChangeManagement.MrOt 

 

 

https://help.deltek.com/Product/Cobra/8.6/GA/Change%20Management%20Tags.html
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Cobra 8.6 Cumulative Update 05 
Released: July 24, 2025 

Enhancements 

There are no enhancements in this release.  

Software Issues Resolved 

This section includes software issues resolved in this release.  

Project Processes » Reclass 

Defect 2417339 

Description: When you ran the Reclass Wizard and the base results matched another Cobra field name, 

Cobra encountered the "SQL error getting base results cursor" error. 

Customers Impacted: This defect affects customers using the Reclass Wizard.  

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 22 (Defect 1699886). 

Files Updated: 

 Cobra.Process.dll 

Resources » Resource View 

Defect 2524265 

Description: When you displayed a resource or code file in the Resource or Code view that did not 

contain correct tag values and clicked the Expand All button, Cobra encountered an unhandled 

exception. 

Customers Impacted: This defect affects customers using resource or code files that are built 

incorrectly. 

Workaround Before Fix: Make sure the resource or code structure has the correct codes and that the 

Rebuild Hierarchy process completes successfully. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 20 (Defect 2373749). 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Security Enhancements 

There are no security enhancements in this release. 
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Database Changes 

There are no database changes in this release. 

Data Changes 

There are no data changes in this release. 

Documentation Changes 

There are no documentation changes in this release. 
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Cobra 8.6 Cumulative Update 04 
Released: June 26, 2025 

Enhancements 

There are no enhancements in this release.  

Software Issues Resolved 

This section includes software issues resolved in this release.  

File » Integration wInsight 

Defect 2398104 

Description: When you ran the wInsight Wizard, Cobra exported the Total Allocated Budget value using 

the formula CBB - OTB instead of the correct formula, BAC + MR + UB. 

Customers Impacted: This defect affects customers using the wInsight Wizard. 

Workaround Before Fix: Manually edit the Total Allocated Budget value in wInsight Analytics under Data 

Input » Contract Setup » Report Setup » CPR Header. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 21 (Defect 351241). 

Files Updated: 

 Cobra.Process.dll 

Security Enhancements 

There are no security enhancements in this release. 

Database Changes 

There are no database changes in this release. 

Data Changes 

There are no data changes in this release. 

Documentation Changes 

There are no documentation changes in this release. 
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Cobra 8.6 Cumulative Update 03 
Released: May 30, 2025 

Enhancements 

There are no enhancements in this release.  

Software Issues Resolved 

This section includes software issues resolved in this release.  

Codes » Code View 

Defect 2372506 

Description: When you added codes to a code file, Cobra did not automatically convert them to 

uppercase and instead stored them in mixed-case format. 

Customers Impacted: This defect affects customers using Cobra in a non-case-insensitive database. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

File » Integration Cost Data Export 

Defect 2382901 

Description: When you ran the Cost Data Wizard to generate the DOE PARS file, the DS03 EVT field in 

the JSON file displayed EVT_J_Percent instead of EVT_J_pct. 

Customers Impacted: This defect affects customers running the Cost Data Wizard for DOE PARS 

export. 

Workaround Before Fix: Update the DS03 EVT field in the JSON file. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 20 (Defect 2370712). 

In addition, the Cobra Control Account EVT field description in the “Export Structures Page of the Cost 

Data Wizard” topic in the Cobra Help System has been updated to reflect this update. 

Files Updated: 

 PPM.CommonData.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

https://help.deltek.com/Product/Cobra/8.6/GA/Export%20Structures%20Page%20of%20the%20Acumen%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Export%20Structures%20Page%20of%20the%20Acumen%20Wizard.html
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 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

File » Integration Wizard-Project Data 

Defect 2382898 

Description: When you ran the Integration Wizard and did not select the Load opening percent option 

on the Progress page, Cobra did not populate the opening % value for work packages with User Defined 

progress technique. 

Customers Impacted: This defect affects customers using the Integration Wizard. 

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 20 (Defect 2346624). 

In addition, the description of the Load opening percent option in the “Progress Page of the Integration 

Wizard-Scheduling Tools” topic has been updated to correctly describe the behavior of the option. 

Files Updated: 

 Cobra.Process.dll 

Defect 2382899 

Description: When you ran the Integration Wizard and loaded resource assignments from an import file, 

Cobra incorrectly populated the BAC value stored in the COSTELEM table under the following 

conditions: 

 The Use one file with activity and resource assignment data option on the Project Selection 

page was selected. 

 The base result from the import file was not the only result listed on the Import File Field Mapper 

page. 

This resulted in incorrect values during the execution of the Respread process.  

Customers Impacted: This defect affects customers using the Integration Wizard. 

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 20 (Defect 2369310). 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

https://help.deltek.com/Product/Cobra/8.6/GA/Earned%20Value%20Page%20of%20the%20Integration%20Wizard%20Scheduling%20Tools.html
https://help.deltek.com/Product/Cobra/8.6/GA/Earned%20Value%20Page%20of%20the%20Integration%20Wizard%20Scheduling%20Tools.html
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Defect 2382900 

Description: When you loaded data using the Primavera-Integration Wizard and selected a Primavera 

activity code field in the Load Progress Technique from Schedule field on the Progress page, Cobra did 

not retrieve the Primavera code value and instead changed the progress technique to the value selected 

in the Blank Progress Technique use field. 

Customers Impacted: This defect affects customers using the Primavera-Integration Wizard. 

Workaround Before Fix: Perform the following steps: 

1. Create a User-Defined column in Primavera and use it to store the progress technique. 

2. When you run the Integration Wizard, select the User-Defined column you created in the Load 

Progress Technique from Schedule field on the Progress page. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 20 (Defect 2342795). 

Files Updated: 

 Cobra.Process.dll 

Help 

Defect 2384399 

Description: The Cobra Help System did not mention that the role security did not apply to Integration 

and wInsight configurations as well as in views. 

Customers Impacted: This defect affects all customers. 

Workaround Before Fix: None. 

Additional Notes: The Role field description in the "Manage Views Dialog Box" and "Configuration 

Security Dialog Box" topics have been updated. 

Installation 

Defect 2388702 

Description: When you upgraded Cobra using silent installation, the warning prompt for the database 

changes was not captured in the install file.  

Customers Impacted: This defect affects customers performing silent installation.  

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 21 (Defect 2384066). 

Files Updated: 

 DeltekCobra86.exe 

https://help.deltek.com/Product/Cobra/8.6/GA/Manage%20Views%20Dialog%20Box.html
https://help.deltek.com/Product/Cobra/8.6/GA/Configuration%20Security%20Dialog%20Box.html
https://help.deltek.com/Product/Cobra/8.6/GA/Configuration%20Security%20Dialog%20Box.html
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Defect 2388704 

Description: When you ran the Cobra installer for a workstation installation, the warning prompt for the 

Cobra 8.5 Cumulative Update (CU) 16 database changes was still displayed—even if you were 

upgrading from CU 16 or a later version. 

Customers Impacted: This defect affects customers performing a workstation installation. 

Workaround Before Fix: None. 

Customers Impacted:  This defect affects customers performing a workstation installation. 

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 21 (Defect 2384067). 

Files Updated: 

 DeltekCobra86.exe 

Project Processes » Freeze Forecast 

Defect 2316200 

Description: When you ran the Freeze Forecast Wizard and selected multiple control accounts or work 

packages on the Criteria Selection page, Cobra froze only one control account or work package. 

Customers Impacted: This defect affects customers using the Freeze Forecast Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

Rates 

Defect 2382902 

Description: When you clicked Rates in the Navigation pane of the Cobra Explorer and there were 

multiple rate files in the WST_DIR table with the same DIR_ID (for instance, xyz and XYZ), Cobra 

encountered an unhandled exception. 

Customers Impacted: This defect affects customers logging into the Cobra application. 

Workaround Before Fix: Rename or delete the duplicate WST_DIR records. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 20 (Defect 2347630). 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 
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 Cobra.Resources.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Security Enhancements 

This section includes security enhancements in this release. 

Deltek Tracking Number 2355285 

Security enhancements were made to address findings from ongoing security monitoring. 

Database Changes 

There are no database changes in this release. 

Data Changes 

There are no data changes in this release. 

Documentation Changes 

There are no documentation changes in this release. 
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Cobra 8.6 Cumulative Update 02 
Released: April 29, 2025 

Enhancements 

This section includes enhancements in this release.  

DOE PARS Export Updates 

You can now capture the apportioned work packages in the JSON file when the EVT is set to 

Apportioned (EVT = "J") or Calculated Apportionment (EVT = "M"): 

 A new field, EVT_J_to_WBS_ID, with a value of Many, will be added to the DS03_cost.json file. 

 A new field, EVT_J_Percent, with a value of 100, will be added to the DS03_cost.json file. 

  

Support for Primavera P6 24.12 

Cobra now supports Primavera® P6 24.12.  

 

Software Issues Resolved 

This section includes software issues resolved in this release.  

Documentation 

Defect 2364899 

Description: When you followed Step 1 in the "Perform Client Installation on a Workstation" section of 

the Deltek Cobra 8.6 Installation Guide, it incorrectly stated that you needed administrative rights. 

Customers Impacted: This defect affects all customers. 

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 20 (Defect 2346680). 

Files Updated:  

 DeltekCobra86InstallationGuide.pdf 

Note: This information is documented in the “Export Structures Page of the Cost Data Wizard” topic 

in the Cobra Help System. 

Note: This information is documented in the “System Requirements” section of the Deltek Cobra 8.6 

Installation Guide and Deltek Cobra 8.6 Technical Overview and System Requirements Guide. 

https://help.deltek.com/Product/Cobra/8.6/GA/Export%20Structures%20Page%20of%20the%20Acumen%20Wizard.html
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File » Integration Cost Data Export 

Defect 2358920 

Description: When you ran the Cost Data Wizard to export IPMDAR cost data, the 

SummaryIndirectPerformance_ToDate.json and SummaryIndirectPerformance_ToComplate.json files 

did not display periods with negative values. 

Customers Impacted: This defect affects customers using the Cost Data Wizard. 

Workaround Before Fix: Manually add the missing periods in the 

SummaryIndirectPerformance_ToComplete.json and SummaryIndirectPerformance_ToDate.json files. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 19 (Defect 2251342). 

Files Updated:  

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 PPM.CommonData.dll 

File » Integration Wizard-Project Data 

Defect 2358923 

Description: When you ran the Open Plan-Integration Wizard, Cobra encountered the "Variable 

'CST_CLASS' not found" error under the following conditions: 

 The Code Assignments and User Fields and Resource Assignments options on the Action 

Selection page were selected. 

 The Load budget class from field option on the Resource Assignments page was selected and 

set to Cost Class (Assignment). 

Customers Impacted: This defect affects customers using the Open-Integration Wizard. 

Workaround Before Fix: Use two separate configuration files to import Code Assignments and User 

Fields and Resource Assignments. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 19 (Defect 2320574). 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 
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Projects » Project View 

Defect 2358921 

Description: When you used the Save As function on a project with a large number of time-phased 

records on a SQL Server database, Cobra encountered a lock escalation issue, causing other processes 

to be halted until the time-phased records were copied. 

Customers Impacted: This defect affects customers using the Save As function on a SQL Server 

database.  

Workaround Before Fix: Do one of the following actions: 

 Run the Copy Project process through the API during off hours. 

 Use the Restore process. 

 Set READ_COMMITTED_SNAPSHOT = YES in SQL Server to mitigate the lock escalation issue 

while optimizing the queries. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 19 (Defect 2115945). 

Files Updated: 

 Cobra.Process.dll 

Security Enhancements 

There are no security enhancements in this release. 

Database Changes 

There are no database changes in this release. 

Data Changes 

There are no data changes in this release. 

Documentation Changes 

This section includes details of section changes in the printed documentation that are in addition to any 

enhancements. 

Document Details 

Deltek Cobra 8.6 Help System  Updated the description of the Include all 

children field in the following topics: 

 “Criteria Page of the Replan Wizard” 

 “Criteria Selection Page of the 

Respread Wizard” 

https://help.deltek.com/Product/Cobra/8.6/GA/Criteria%20Page%20of%20the%20Replan%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Criteria%20Selection%20Page%20of%20the%20Respread%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Criteria%20Selection%20Page%20of%20the%20Respread%20Wizard.html
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Document Details 

 “Criteria Selection Page of the 

Recalc Wizard” 

 “Criteria Selection Page of the Zero-

Out Data Wizard” 

 “Criteria Selection Page of the Top-

Down Planning Wizard” 

 “Criteria Page of the Reclass Wizard” 

 “Criteria Selection Page of the 

Update Codes Wizard” 

https://help.deltek.com/Product/Cobra/8.6/GA/Criteria%20Selection%20Page%20of%20the%20Recalc%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Criteria%20Selection%20Page%20of%20the%20Recalc%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Criteria%20Selection%20Page%20of%20the%20Zero%20Out%20Data%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Criteria%20Selection%20Page%20of%20the%20Zero%20Out%20Data%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Criteria%20Selection%20Page%20of%20the%20Top%20Down%20Planning%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Criteria%20Selection%20Page%20of%20the%20Top%20Down%20Planning%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Criteria%20Page%20of%20the%20Reclass%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Criteria%20Selection%20Page%20of%20the%20Update%20Codes%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Criteria%20Selection%20Page%20of%20the%20Update%20Codes%20Wizard.html
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Cobra 8.6 Cumulative Update 01 
Released: March 31, 2025 

Enhancements 

This section includes enhancements in this release.  

DOE PARS Export Updates 

The following DOE PARS Export updates are included in this release: 

 WBS and OBS records with blank PARS IDs will not be exported or included in the DS01 and 

DS02 json files. However, if a parent element has no PARS ID but its children have PARS IDs, 

both the parent and children will be exported or included in the DS01 and DS02 json files. A 

single warning message will be created in the process log if multiple WBS or OBS records are 

missing PARS IDs. 

 When a control account or work package uses a WBS or OBS that has a blank PARS ID, it will not 

be exported in the DS03 json file. In addition, if a parent element with a blank PARS ID is 

included in the DS01 or DS02 json file because its children have valid PARS IDs, and the parent 

element is used in the CAWP project data, the parent element will still not be exported or 

included in the DS03 json file. 

  

 Previously, Cobra work packages were aggregated only at the work package level. Now, they are 

aggregated by the WBS_ID_WP field. In the DS03 json file, the aggregation combines the 

period_date, WBS_ID_CA, WBS_ID_WP, EOC, EVT, and is_indirect fields. Multiple Cobra work 

packages associated with a single WBS_ID_WP field are aggregated accordingly. 

 

 A new field called Cobra Control Account EVT has been added to the Export Structures Page of 

the Cost Data Wizard. This field allows you to select a valid Cobra control account code 

assignment to populate the DS03 EVT field in the json file.  

This field is enabled only when the Activities loaded as Work Package checkbox is selected. If 

the checkbox is not selected, Cobra will populate the DS03 EVT field from the standard work 

package EVT. 

Note: This information is documented in the “WBS/OBS Codes Page of the Cost Data 

Wizard” topic in the Cobra Help System. 

Note: This information is documented in the “Export Structures Page of the Cost Data 

Wizard” topic in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.6/GA/WBS%20OBS%20Codes%20Page%20of%20the%20Cost%20Data%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/WBS%20OBS%20Codes%20Page%20of%20the%20Cost%20Data%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Export%20Structures%20Page%20of%20the%20Acumen%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Export%20Structures%20Page%20of%20the%20Acumen%20Wizard.html
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   Export Structures Page of the Cost Data Wizard 

 

Installation Wizard Update  

The Deltek Cobra Installation Wizard has been updated to remove the Microsoft SQL Server and Oracle 

versions from the Setup Type page. 

  

Setup Page of the Installation Wizard 

 

Note: This information is documented in the “Export Structures Page of the Cost Data 

Wizard” topic in the Cobra Help System. 

Note: The related sections in the “Cobra New Installation Procedures” chapter of the Deltek Cobra 

8.6 Installation Guide have been updated accordingly. 

https://help.deltek.com/Product/Cobra/8.6/GA/Export%20Structures%20Page%20of%20the%20Acumen%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Export%20Structures%20Page%20of%20the%20Acumen%20Wizard.html
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Software Issues Resolved 

This section includes software issues resolved in this release.  

Help 

Defect 2317971 

Description: When you accessed the "Delete a Resource from a Resource File" topic, it incorrectly stated 

that deleting multiple resources at the same time was allowed.  

Customers Impacted: This defect affects customers accessing the Cobra Help System.  

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 17 (Defect 2292962). 

Files Updated: 

 Delete a Resource from a Resource File.html 

Defect 2268577 

Description: The "Merge Sub-Projects into a New Project" topic contained incorrect information about 

handling duplicate records during the merging of sub-projects. 

Customers Impacted: This defect affects all customers.  

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 15 (Defect 2260350). 

Files Updated: 

 Merge Sub Projects Into a New Project.html 

Defect 2336414 

Description: The user-defined data field type Decimal was not specified in the field descriptions for 

Load milestone weights, Load opening percent, and Load units to do in the “Progress Page of the 

Integration Wizard-Scheduling Tools” topic. 

Customers Impacted: This defect affects all customers. 

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 18 (Defect 2306111). 

Files Updated: 

 Earned Value Page of the Integration Wizard Scheduling Tools.html 

https://help.deltek.com/Product/Cobra/8.6/GA/Delete%20a%20Resource%20from%20a%20Resource%20File.html
https://help.deltek.com/Product/Cobra/8.6/GA/Merge%20Sub%20Projects%20Into%20a%20New%20Project.html
https://help.deltek.com/Product/Cobra/8.6/GA/Earned%20Value%20Page%20of%20the%20Integration%20Wizard%20Scheduling%20Tools.html
https://help.deltek.com/Product/Cobra/8.6/GA/Earned%20Value%20Page%20of%20the%20Integration%20Wizard%20Scheduling%20Tools.html
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File » Integration wInsight 

Defect 2268574 

Description: When you ran the wInsight Wizard, the work package codes associated with the selected 

project did not display on the Work Package Codes page.  

Customers Impacted: This defect affects customers using the wInsight Wizard.  

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 15 (Defect 2243290). 

Files Updated: 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

File » Integration Wizard-Project Data 

Defect 2317921 

Description: When you ran the Integration Wizard to load actual costs against a master project, Cobra 

used the status date from the master project when loading into the current period for all the 

subprojects. 

Customers Impacted: This defect affects customers using the Integration Wizard.  

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 17 (Defect 2296350). 

Files Updated: 

 Cobra.Process.dll 

Defect 2268576 

Description: When you ran the Integration Wizard, the Actual Finish Date on the work package did not 

match the Actual Finish Date on the latest milestone. 

Customers Impacted: This defect affects customers using the Integration Wizard.  

Workaround Before Fix: Run the Integration Wizard again. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 15 (Defect 481977). 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 
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Defect 2294309 

Description: When you loaded data using the Primavera-Integration Wizard, where an activity level code 

was selected in the Load Progress Technique from Schedule field on the Progress page and all other 

fields in the Integration Wizard were user-defined fields, Cobra encountered the "KEYCODES is not 

found" error. 

Customers Impacted: This defect affects customers using the Primavera-Integration Wizard.  

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 16 (Defect 2262048). 

Files Updated: 

 Cobra.Process.dll 

Defect 2268573 

Description: When you ran the Integration Wizard to load actual costs against a master project, Cobra 

used the status date from the master project when loading into the current period for all the 

subprojects. 

Customers Impacted: This defect affects customers using the Integration Wizard.  

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 15 (Defect 2239517). 

Files Updated: 

 Cobra.Process.dll 

Defect 2336411 

Description: When you ran the Integration Wizard, the progress technique of a work package did not 

change if it was set to Assignment % Complete and the schedule or file had a different progress 

technique. 

Customers Impacted: This defect affects customers using the Integration Wizard.  

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 18 (Defect 1515779). 

Files Updated: 

 Cobra.Process.dll 
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Defect 2336409 

Description: When you loaded data using the Primavera-Integration Wizard, Cobra encountered the 

"Field <field> does not accept null values" error. 

Customers Impacted: This defect affects customers using the Primavera-Integration Wizard on an 

Oracle database. 

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 18 (Defect 2253203). 

Files Updated: 

 Cobra.Process.dll 

Login 

Defect 2336407 

Description: When you logged into Cobra and there were multiple project records in the WST_DIR table 

with the same DIR_ID (for instance, xyz and XYZ), Cobra encountered the following error: "Failed to 

enable constraints. One or more rows contain values violating non-null, unique, or foreign-key 

constraints."  

Customers Impacted: This defect affects customers logging into the Cobra application. 

Workaround Before Fix: Rename or delete the duplicate WST_DIR records. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 18 (Defect 2227048). 

The application checks for duplicate project names when this error occurs. In addition, Cobra can 

automatically resolve these duplicates by renaming them to avoid conflicts with other projects. 

However, if you prefer, you can manually handle these duplicate project names. 

  

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.Resources.dll 

Attention: For more information on how to manually handle duplicate project names, see the 

following topics in the Cobra Help System: 

 “Fixing Duplicate Project Names” 

 “Identify Duplicate Project Names” 

 “Update the Duplicate Project Names” 

https://help.deltek.com/Product/Cobra/8.6/GA/Fixing%20Duplicate%20Project%20Names.html
https://help.deltek.com/Product/Cobra/8.6/GA/Identify%20Duplicate%20Project%20Names.html
https://help.deltek.com/Product/Cobra/8.6/GA/Update%20the%20Duplicate%20Project%20Names.html
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 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Projects » Project Information 

Defect 2294315 

Description: The Total Over Target Baseline (OTB) field on the Budget tab of the Project Properties 

dialog box displayed a reconciled value of 0 instead of the actual project header OTB value, which was 

the negative Distributed OTB value from Cobra 8.4 and earlier versions.  

Customers Impacted: This defect affects customers accessing the Budget tab of the Project Properties 

dialog box. 

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 16 (Defect 2276385). 

The OTB project header value from Cobra 8.4 backups is recognized as Distributed Over Target 

Baseline. This means that if there were OTB values in the Cobra 8.4 project, opening the Project Audit 

Wizard reconciles the Project OTB header with the correct OTB values in the log. 

Files Updated: 

 Cobra.Process.dll 

 Cobra.Model.*.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Defect 2294308 

Description: When you added a budget to a project with the project audit logging turned off, Cobra did 

not calculate the Undistributed Budget, Distributed Budget, and Distributed OTB values correctly on the 

Budget tab of the Project Properties dialog box. 

Customers Impacted: This defect affects customers using the Project Audit Wizard.  

Workaround Before Fix: Run the following script to remove the Undistributed Budget value:  

update PROGRAM 

set UB = 0 

where PROGRAM = 'ENTER_PROGRAM_NAME_HERE' ; 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 16 (Defect 1198257). 

Files Updated: 

 Cobra.Process.dll 
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 Cobra.Model.*.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Project Processes » Calculate Progress 

Defect 2294307 

Description: When you ran the Calculate Progress Wizard, Cobra incorrectly computed the EAC value if 

the EAC value stored in the CAWP table was incorrect.  

Customers Impacted: This defect affects customers using the Calculate Progress Wizard. 

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 16 (Defect 1182745). 

When the Scale retain EAC field on the Forecast Preferences tab of the Project Properties dialog box is 

set to Currency, Hours, or Hours and Currency and you click the Finish button on the Confirmation 

page of the Calculate Progress Wizard, Cobra will prompt you to choose whether to update the Estimate 

At Complete (EAC) values or not during the total calculation. This may result in changes to the existing 

control account or work package EAC values.  

  

When you run the Calculate Progress process through the API, you can use the UpdateEAC setting. 

  

Files Updated: 

 Cobra.Api.exe 

 Cobra.Model.dll 

 Cobra.Model.WebService.dll 

 Cobra.WinUI.Processes.dll 

Attention:  

 For more information, see the "Forecast Preferences", "Calculate Progress Process", and 

"Confirmation Page of the Calculate Progress Wizard" topics in the Cobra Help System. 

 The “Calculate Progress Service Arguments Properties” topic in the Cobra Web Service 

ClientAPI Help System has been updated to include the UpdateEAC setting. 

https://help.deltek.com/Product/Cobra/8.6/GA/Forecast%20Preferences.html
https://help.deltek.com/Product/Cobra/8.6/GA/Calculate%20Progress%20Process.html
https://help.deltek.com/Product/Cobra/8.6/GA/Confirmation%20Page%20of%20the%20Calculate%20Progress%20Wizard.html
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 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Project Processes » Project Audit 

Defect 2294304 

Description: When you ran the Project Audit Wizard and turned on the project log, the Distributed 

Budget, Undistributed Budget, and Over Target Baseline fields on the Set Project Baseline page did not 

populate with values.  

Customers Impacted: This defect affects customers using the Project Audit Wizard.  

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 16 (Defect 2239237). 

Files Updated: 

 Cobra.Model.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Project Processes » Replan 

Defect 2317925 

Description: When you ran the Replan Wizard, Cobra created orphaned records under any of the 

following conditions: 

 The Select the Level at Which to Capture Actual Costs field on the Files tab of the Project 

Properties dialog box was set to Both Control Account and Work Package or Control Account. 

 The Replan by adding an adjusting entry in the current period option on the Options page was 

selected. 

 Time-phased entries existed prior to the status date for an actual class for a completed work 

package. 

Customers Impacted: This defect affects customers using the Replan Wizard. 

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 17 (Defect 2278407). 

Files Updated: 
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 Cobra.Process.dll 

Defect 2294305 

Description: When you ran the Replan Wizard, Cobra created orphaned records under any of the 

following conditions:  

 The Select the Level at Which to Capture Actual Costs field on the Files tab of the Project 

Properties dialog box was set to Both Control Account and Work Package or Control Account. 

 The Replan by adding an adjusting entry in the current period option on the Options page was 

not selected. 

 The Create a new Work Package for the replanned Budget/Progress/Actuals option on the 

Options page was selected.  

 Time-phased entries existed prior to the status date for a budget class (the Included in Budget 

option not selected) for more than one work package, or for a work package where the prior 

work package was not replanned.  

Customers Impacted: This defect affects customers using the Replan Wizard.  

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 16 (Defect 2165621). 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Reports 

Defect 2294312 

Description: When you viewed the Project Audit report, the Total Allocated Budget (TAB) formula was 

incorrect.  

Customers Impacted: This defect affects customers running the Project Audit report. 

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 16 (Defect 2260395). 

Files Updated: 

 Report Template Project Audit.xlsx 
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Reports » Reports 

Defect 2268572 

Description: When you ran the Project Audit report, any Distributed OTB added to the project was 

displayed as a negative value in the Distributed OTB column instead of a positive value. Conversely, any 

Distributed OTB removed from the project was displayed as a positive value in the Distributed OTB 

column instead of a negative value. 

Customers Impacted: This defect affects customers running the Project Audit report. 

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.5 Cumulative Update 15 (Defect 2219778). 

Files Updated: 

 Cobra.ReportLayoutEngine.dll 

Security Enhancements 

There are no security enhancements in this release. 

EPM Security Administrator Updates 

This section includes EPM Security Administrator updates in this release. 

Software Issues Resolved 

This section includes software issues resolved in this release.  

Defect 2317871 

Description: When you tried to import users from Outlook, an Unhandled Exception error would occur. 

Customers Impacted: EPM Security Administrator users importing users from Microsoft Outlook. 

Workaround Before Fix: None. 

Defect 2254110 

Description: You could not log in with a user ID exceeding 16 characters, even though no such 

restriction was set during user record creation 

Customers Impacted: EPM Security Administrator users with user ID exceeding 16 characters. 

Workaround Before Fix: Create users with user IDs containing fewer than 16 characters. 

Database Changes 

There are no database changes in this release. 

Data Changes 

There are no data changes in this release. 
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Documentation Changes 

This section includes details of section changes in the printed documentation that are in addition to any 

enhancements. 

Document Details 

Deltek Cobra 8.6 Help System  Added a note to the Level field description 

in the “Export Structures Page of the 

wInsight Wizard” topic 

 Created the following topics to discuss 

configuring SSL in Cobra n-tier: 

 “Configuring Cobra N-Tier to Use 

Secure Socket Layers” 

 “Obtain the Authentication 

Certificate Information on the Cobra 

N-Tier Server” 

 “Bind the Windows Server 

Certificate to the Cobra N-Tier 

Service HTTPS Port” 

 “Update the Cobra Configuration 

Files to Use HTTPS” 

 “Update the Cobra N-Tier Server to 

Use HTTPS” 

 “Update Cobra on Existing 

Workstations to Use HTTPS” 

 “Revert to Using the Default Cobra 

N-Tier Setup” 

 Created the following topics to discuss the 

types of security applied when enabling and 

disabling the Cobra menu items: 

 “Enabling and Disabling of Cobra 

Menu Items” 

 “Application-Level Security” 

 “File-Based Security” 

https://help.deltek.com/Product/Cobra/8.6/GA/Export%20Structures%20Page%20of%20the%20wInsight%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Export%20Structures%20Page%20of%20the%20wInsight%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Configuring%20N%20Tier%20to%20Use%20SSL.html
https://help.deltek.com/Product/Cobra/8.6/GA/Configuring%20N%20Tier%20to%20Use%20SSL.html
https://help.deltek.com/Product/Cobra/8.6/GA/Obtain%20the%20Authentication%20Certificate%20on%20the%20N%20Tier%20Server.html
https://help.deltek.com/Product/Cobra/8.6/GA/Obtain%20the%20Authentication%20Certificate%20on%20the%20N%20Tier%20Server.html
https://help.deltek.com/Product/Cobra/8.6/GA/Obtain%20the%20Authentication%20Certificate%20on%20the%20N%20Tier%20Server.html
https://help.deltek.com/Product/Cobra/8.6/GA/Bind%20the%20Windows%20Server%20Certificate%20to%20the%20N%20Tier%20Service%20HTTPS%20Port.html
https://help.deltek.com/Product/Cobra/8.6/GA/Bind%20the%20Windows%20Server%20Certificate%20to%20the%20N%20Tier%20Service%20HTTPS%20Port.html
https://help.deltek.com/Product/Cobra/8.6/GA/Bind%20the%20Windows%20Server%20Certificate%20to%20the%20N%20Tier%20Service%20HTTPS%20Port.html
https://help.deltek.com/Product/Cobra/8.6/GA/Update%20the%20Cobra%20Configuration%20Files%20to%20use%20HTTPS.html
https://help.deltek.com/Product/Cobra/8.6/GA/Update%20the%20Cobra%20Configuration%20Files%20to%20use%20HTTPS.html
https://help.deltek.com/Product/Cobra/8.6/GA/Update%20the%20Cobra%20N-tier%20Server.html
https://help.deltek.com/Product/Cobra/8.6/GA/Update%20the%20Cobra%20N-tier%20Server.html
https://help.deltek.com/Product/Cobra/8.6/GA/Update%20Cobra%20on%20Existing%20Workstations.html
https://help.deltek.com/Product/Cobra/8.6/GA/Update%20Cobra%20on%20Existing%20Workstations.html
https://help.deltek.com/Product/Cobra/8.6/GA/Revert%20to%20Using%20the%20Default%20Cobra%20N-Tier%20Setup.html
https://help.deltek.com/Product/Cobra/8.6/GA/Revert%20to%20Using%20the%20Default%20Cobra%20N-Tier%20Setup.html
https://help.deltek.com/Product/Cobra/8.6/GA/Enabling%20and%20Disabling%20of%20Cobra%20Menu%20Items.html
https://help.deltek.com/Product/Cobra/8.6/GA/Enabling%20and%20Disabling%20of%20Cobra%20Menu%20Items.html
https://help.deltek.com/Product/Cobra/8.6/GA/Application%20Level%20Security.html
https://help.deltek.com/Product/Cobra/8.6/GA/GUID-A5DF1512-4EF0-4FB7-AAD2-3C51A0CB0939.html
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Document Details 

 Updated several topics under the “Security” 

node to correct information related to 

security 

 Updated the following topics to correct the 

location of the WebServiceDebugLog.xml 

and 

CobraWebServiceGatewayDebugLog.xml 

files: 

 “Cobra Web Service Log 

 “Cobra Logs” 

 Added a note to the Level field description 

in the “Export Structures Page of the 

wInsight Wizard” topic 

 Added ReprogCVA and ReprogSVA to the 

“Classes Tab of the Project Properties Dialog 

Box” topic 

 Updated the description of the Use 

WBS/OBS combination as Control Account 

field in the “Data Options Page of the Cost 

Data Wizard” topic 

Deltek Cobra 8.6 Installation Guide  Added a note recommending the use of 

Oracle Client 19c or later when using Oracle 

Provider for OLE DB in the “Supported 

Deployment Technology” and “Supported 

Providers” sections 

 Updated the screenshots in “Appendix G: 

Configuring Oracle Primavera P6 for 

Integration” 

Deltek Cobra 8.6 Technical Overview and System 

Requirements Guide 

 Added a note recommending the use of 

Oracle Client 19c or later when using Oracle 

Provider for OLE DB in the “Supported 

Deployment Technology” section 

https://help.deltek.com/Product/Cobra/8.6/GA/Security.html
https://help.deltek.com/product/Cobra/8.6/GA/Cobra%20Web%20Service%20Log.html
https://help.deltek.com/product/Cobra/8.6/GA/Cobra%20Logs.html
https://help.deltek.com/Product/Cobra/8.6/GA/Export%20Structures%20Page%20of%20the%20wInsight%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Export%20Structures%20Page%20of%20the%20wInsight%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Classes%20Tab%20of%20the%20Project%20Properties%20Dialog%20Box.html
https://help.deltek.com/Product/Cobra/8.6/GA/Classes%20Tab%20of%20the%20Project%20Properties%20Dialog%20Box.html
https://help.deltek.com/Product/Cobra/8.6/GA/Cost%20and%20Burden%20Details%20Page%20of%20the%20Acumen%20Wizard.html
https://help.deltek.com/Product/Cobra/8.6/GA/Cost%20and%20Burden%20Details%20Page%20of%20the%20Acumen%20Wizard.html
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Document Details 

Deltek Cobra 8.6 Essentials  Updated the Setup Type Page of the 

Installation Wizard screenshot in “Appendix 

A: Before You Explore Cobra” 
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Appendix A: Download and Install the 
Cumulative Update  
You can use Deltek Software Manager (DSM) to download complete Deltek products, hot fixes, 

cumulative updates, and sub-releases. You can access DSM through the Deltek Support Center or use 

Deltek Software Manager Lite to download Deltek products. 

Access DSM and Download the Cumulative Update 

Use these instructions to download the cumulative update from DSM. 

To download the cumulative update: 

1. Using your web browser, go to https://dsm.deltek.com.  

2. Enter your Deltek Support Center Username and Password, and click Login. 

3. When the Deltek Support Center page displays, click Product Downloads. 

4. On the Deltek Software Manager screen, click Launch Deltek Software Manager. 

5. Click Run Deltek Software Manager.  

6. Log in using your Deltek Support Center credentials. 

7. In the Deltek Software Manager dialog box, at the top right, click Settings. 

8. In the Settings dialog box, specify the folder where you want to download the Deltek products, 

and click OK. 

 

9. In the left pane, expand the Deltek product that you want to download, if it is not already 

expanded, and select Cumulative Update. 

10. In the table, select the checkbox that corresponds to the cumulative update that you want to 

download. 

The right pane displays a message stating that the product has been added to the download 

queue. 

 

Note: When you log on for the first time, DSM asks you to select a default folder where 

Deltek products are to be downloaded. You can change this folder anytime in the Settings 

dialog box. 

Note: To view the items in the download queue, click View Download Queue at the bottom 

of the left pane. 

https://dsm.deltek.com/
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11. Click Download at the bottom of the left pane to download the product to the folder that you 

selected. 

Install the Cumulative Update 

The instructions for installing an update for Cobra 8.x and higher depend on your type of deployment. 

Use the instructions below that apply to your deployment scenario. 

  

If You Use a Deployment Server 

Use these instructions if you are using Cobra on a client/server (deployment server) deployment. 

To install the cumulative update on the server: 

1. Launch the update on the server.  

 

2. The Welcome screen displays the current build, along with the new build being installed by the 

update. Click Next to begin the installation.  

The installation Wizard installs all necessary files and displays the Update Complete form.  

3. Click Finish.  

4. Depending on the type of update, a reboot may be required. If the option to reboot your 

computer is enabled, select it and click Finish.  

5. Launch the Deltek Cobra shortcut on client workstations to initiate the update. 

To install the cumulative update on a client workstation: 

1. Launch the Deltek Cobra shortcut.  

Cobra detects that an updated version is available and displays the prompt: Do you want to 

install the upgrade?  

2. Click Yes to start the installation, or click No to cancel the installation.  

When the installation is completed, the installation Wizard closes.  

Note: You must install the entire update package. If an update addresses more than one defect, you 

cannot fix one defect at a time. 

Note: If the update detects that Cobra is already running, you will see a prompt asking if you 

want to close Cobra. Click Yes to start the installation, or click No to cancel the installation. 
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3. Launch the Deltek Cobra shortcut to log into Cobra. 

If You Have an N-Tier Deployment 

Use these instructions if you are using Cobra on an n-tier deployment. 

To install the cumulative update on the server: 

1. Launch the update on the server.  

 

2. The Welcome screen displays the current build, along with the new build being installed by the 

update. Click Next to begin the installation.  

The installation Wizard installs all necessary files and displays the Update Complete form.  

3. Click Finish. 

4. Depending on the type of update, a reboot may be required. If the option to reboot your 

computer is enabled, select it and click Finish. 

5. Launch the Deltek Cobra shortcut on n-tier client workstations to initiate the update. 

To install the cumulative update on an n-tier client workstation: 

1. Launch the Deltek Cobra shortcut.  

Cobra detects that an updated version is available and displays the prompt: Do you want to 

install the upgrade?  

2. Click Yes to start the installation, or click No to cancel the installation.  

If you choose Yes, the installation Wizard copies the updated DeltekCobraWorkstation.exe file 

locally and automatically begins installing files. When the installation is completed, the 

installation Wizard closes.  

Launch the Deltek Cobra shortcut to log into Cobra. 

If You Have a Terminal Services/Citrix Deployment 

Use these instructions if you are using Cobra on a terminal services/Citrix deployment. 

To install the cumulative update on the deployment server: 

1. Launch the update on the server. 

Note: If the update detects that Cobra is already running, you will see a prompt asking if you 

want to close Cobra. Click Yes to start the installation, or click No to cancel the installation. 
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2. The Welcome screen displays the current build, along with the new build being installed by the 

update. Click Next to begin the installation.  

The installation Wizard installs all necessary files and displays the Update Complete form.  

3. Click Finish. 

4. Depending on the type of update, a reboot may be required. If the option to reboot your 

computer is enabled, select it and click Finish. 

5. Log on as a Local Administrator on the Terminal Server/Application Server and install the update. 

To install the cumulative update on the Terminal Server/ Application Server (the server on which the 

Cobra client runs): 

1. Log onto the Terminal Server using an account that has Local Administrator privileges.  

When the setup launches, the installation program installs all necessary files and any registry 

updates and makes these changes available to all users who will subsequently log on to the 

Terminal Server session to run Cobra.  

2. Ensure that no instance of Cobra is running.  

3. Open the shared Cobra Workstation folder (usually located on the deployment server, as 

\\{DeploymentServerName}\CobraWorkstation\DeltekCobraWorkstation.exe).  

4. Launch the DeltekCobraWorkstation.exe file to install the update.  

The Welcome screen displays, showing that the update is available.  

5. Click Next to start the installation.  

6. When the installation completes, launch the Deltek Cobra shortcut to log into Cobra and confirm 

that the update is installed, meaning that users can now launch Cobra via Terminal 

Services/Citrix sessions. 

If You Have a Stand-Alone Deployment 

Use these instructions if you are using Cobra on a stand-alone deployment. 

To install the cumulative update on the workstation: 

1. Verify that Cobra is not running.  

2. Launch the update on the server.  

Note: If the update detects that Cobra is already running, you will see a prompt asking if you 

want to close Cobra. Click Yes to start the installation, or click No to cancel the installation. 
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3. The Welcome screen displays the current build, along with the new build being installed by the 

update. Click Next to begin the installation.  

The installation Wizard installs all necessary files and displays the Update Complete form.  

4. Click Finish.  

5. Depending on the type of update, a reboot may be required. If the option to reboot your 

computer is enabled, select it and click Finish. 

6. Launch the Deltek Cobra shortcut to log into Cobra. 

Confirm that the Cumulative Update Is Installed 

Use these instructions to check that the version number reflects the installed cumulative update. 

To confirm that the cumulative update is installed: 

1. Click   » Help » About Deltek Cobra. 

2. Check that the version number reflects the installation of the update. 
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Appendix B: For Additional Information 
Deltek Support Center 

The Deltek Support Center is a support Web site for Deltek customers who purchase an Ongoing 

Support Plan (OSP).  

The following are some of the many options that the Deltek Support Center provides: 

 Search for product documentation, such as release notes, install guides, technical information, 

online help topics, and white papers 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers through the 

Deltek Support Center Community 

 Access Cloud-specific documents and forums 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Submit a support case and check on its progress 

 Transfer requested files to a Deltek Support Services analyst 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

 Initiate a Chat to submit a question to a Deltek Support Services analyst online 

 

Access Deltek Support Center 

To access the Deltek Support Center:  

1. Go to https://deltek.custhelp.com. 

2. Enter your Deltek Support Center Username and Password. 

3. Click Login. 

 

Attention: For more information regarding Deltek Support Center, refer to the online help available 

from the Web site. 

Note: If you forget your username or password, you can click the Need Help? button on the login 

screen for help. 

https://deltek.custhelp.com/
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